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22 OSLO Videos on the Lambda Research Website

Interface and Overview Videos - https://www.lambdares.com/su/oslo-videos/
e OSLO Overview — A high level overview of the interface

e Understanding and Using the OSLO Check Mark — Keys to using the accept
pending entry and cancel pending entry capability with spreadsheets

e OSLO Spreadsheet Hierarchy — Discusses nuances with the spreadsheet
hierarchy

e OSLO Lens Spreadsheet Presentation — Effective use of the surface data
spreadsheet

e OSLO Top Menu Explanation — An overview of the graphics windows
e OSLO Graphics Window — Details on the graphics window usage and output

e OSLO Text Window and Command Line — Text window and command line usage
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OSLO Videos on the Lambda Research Website

Effective Use, Macro Programming Videos

e Doublet Optimization Tutorial — A set of three videos and an interactive
tutorial to take a doublet from a blank page through optimization

e OSLO Catalog Lens Presentation — Covers effective ways to use catalog
lenses

e OSLO Catalog Lens Tutorial — An interactive tutorial on using catalog lenses
e OSLO Text Editors - Walk-through of the built-in text editors within OSLO

e OSLO Introduction to Modifying, Supplementing, and Programming - An
introduction to programming in OSLO

e OSLO Import CCL Into Notepad++ - Importing the CCL Language into
Notepad++
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Complete set of OSLO Manuals

e OSLO User Guide which walks you through step-by-step examples: -
https://www.lambdares.com/wp-
content/uploads/support/oslo/oslo_releases/OSLOUserGuide.pdf

e OSLO Optics Reference - https://www.lambdares.com/wp-
content/uploads/support/oslo/oslo _releases/OSLOOpticsReference.pdf

e OSLO Programers Reference - https://www.lambdares.com/wp-
content/uploads/support/oslo/oslo_releases/OSLOProgramReference.pdf
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Step by Step Tutorials

The http://wp.optics.arizona.edu/sasian/opt-517/ folder has multiple step by step tutorials:

e OSLO Your First OSLO_ Session.pdf — Good place to start learning OSLO, introduces
you to the interface with a spherical mirror example

e OSLO_Schmidt_Camera.pdf — Demonstrates how to use OSLO by designing a Schmidt
Camera Objective

e OSLO_ Tutorial _Classroom_Demos.pdf
e OSLO_ Tutorial Gaussian_Beam_and_Fiber Coupling.pdf
e OSLO Tutorial Landscape Lens.pdf

e OSLO_Tutorial Optimization OSLO_Standard or_ Premium.pdf

For use in UA Opti 517 Class — All rights reserved -Lambda Resea._’ @o
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Introduction

* User Interface — Setup
— Windows Topics  Preferences

 Menus - Fonts

« Toolbars - Mouse

* Main Window Types . Kevboard
— Graphics : Y

— File and Program
— Text :
Information

— Spreadsheet

* Other Windows
— Command Line
— Database
— Editors
— Slider Wheel
— Catalog Lens
— Printing
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Main Window Types

e Spreadsheet Window
— Only one open at adime
— Latest on top

e Text Window

— Up to 2 open at a time
— Cannot close last

For use in UA Opti 517 Class — All rights reserved -Lambda Resea_

* Graphics Window
— Up to 32 open at a time
— Cannot close last

g [=] 3|

'i_’a Singlet Lens [test singlet len] - 0SLO Premium E dition: i

= Lens Evaluate Optimize Tolerance Source Tools  Window Help
ENQE H @ b i 27 ® b O
|52 O aapp |8 =FE L

B Surface De -
of
% |
?
Setup |[Wavelength || FicW@@oints || Varishles || Draw OFf |[ Groups |[_Neotes |[ == | ~|

Lens: Singlet Lens 1 of 2 Efl  83.170785
Ent beam radius 8.000000 Field angle 5.7296e-05 Frimary wawln 0.587560
SRE RADTUS THICKMESS APERTURE RADIUS GLASS SPECTIAL
oE] 0.000000 ] L.0000e+20(__] 1.0000e+14 A1r [0 [
50.000000 3.o00000 ] 10.000000 BK? 1
-300.000000 0.oo0000 [T 10.000000 [T st ] [T
0.o00000 [ si.470s21 ]  s.oooo00 [ = =
== ==
- G =10l
B Len Spe Rin ‘Wav Puc Abr Mrg Chf Tra Ref Fan Spd Cig Sk Pkp Ape Var Ope Puz Put Chr Sei Fif Zpus Zzpa
bot chf top skw Spe Wl btf Pef Sif Crop Grp
El
nagth: 83.170785 Lateral magnification: -8.317le-19
s 0.0961588 Gaussian image height: 8.3171e-05
wWorking F-number: 5.198174 Fetzval radius: -125.785033
Lagrange inwvariant: -53.0000e-08
-
T A7
|Text output: On |F‘age mode: Off |Graphics autoclear: On |M0use wheel: Fast |Units: mm |Central reference ray mode |Wave|n: 1[0.588) |Aper div: 17.03 S




Menus

'E'E 3-5 Telecentric projection lenz [3-5 telecentrnic.len] - 05L0 Premium Edition

® Main Menu StrUCtU re File Lens Ewaluate Optimize Tolerance Source Tool: ‘Window  Help

— Operates similar to Microsoft menus
— Configured in a_menu.ccl

« OSLO Editor Menu (not UltraEdit or -
Notepad++) ; :

— File & Edit items only
— Not user configured

* Popup Menus
— Right-click (not user configured)
— Attached to SS buttons (not user configured)
— Attached to toolbars (user configured)

5| e
I | M@E%Ei

o Wt [l
Set Zoom Center

Print
Copy to Clipboard
Save bg..

Lock
Clear WWindow
Remove Toolbar

OSLO
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Main Windows Styles

Fle Lens Evaluale Optimze Iokrance Souce Took Window Help
. M ain Window Tille bar
H § 2

[EgSuiface Data

<
x|

Default display, used for routine
tasks

28 Singlet Lens [test_singlet.len] - 0SLO Premium E dition
File Lens Evaluale Dptimize Ioletance Souce Toos Window Help

H@Gb TS @bz O al 000
2O || ma=rr S = =

[serup |[ wavelengrh |[ Field Points |[ variables |[ Draw off |[ Groups |[ Notes |[ ==
Lens: Singler Lens Zoom 1 of 1 Efl s3.17078s
Field angle 5.7296e-05 Primary wavln  0.587560

Ent beam radius

SRF. RADIUS THICKNESS APERTURE RADIUS GLASS SPECIAL
081 0.000000 | 1.0000e+20[ ] 1.0000e+14 AR ] [
.oo0000 [  3.000000 ] 10.000000 i

.oo0000 [ o.o00000 [T 10.000000 [ s [
cooo000 [ sl.47osza ] s.ooo000 [ i

B8 Len Spe Rin Wav Puc Abr Mg Chi Tra Ref Fan Spd

"PARAXIAL CONSTANTS
Effective focal length:  &3.170785 Lateral megnification: -8.3171e-18

Numerical aperture: 0.096188  Gaussian image height:  8.3171le-05
work ing F-number: 5.185174  Petzval radius: -125.785033
Lagrange invariant: -8.0000e-08

[Setup |[ wavelengeh || Field Points || varisbles || Draw off |[ Groups || Notes || == | ~|

Text output On [Page mode: Off [Graphics autockear On

Lens: Singlet Lens 1 of 2 [Efl 83170785
Ent beam radius _ 6.000000 Field angle 5.72962-05 Primary wavln  0.587560

RADIUS THICKNESS APERTURE RADIUS GLASS SPECIAL
000000 [ 1.00008+20 ] 1.0000e+14 AR [
000000 3.000000 ]  10.000000
. 000000 o.o00000 ] 10, 000000 [T AR [
.oooooo [ s1.470s21 [  s.oo0000 [T

Enhanced Style —f

Customized from Standard
with additional toolbars e s e

Numerical aperture: 0.026188  Gawssian imege height:  §.3171le-05
wWorking F-number: 5.188174  Petzval radius: -125.785033
Lagrange invariant: -8.0000e-08

0 Singlet Lens [test_singlet len] - 05L0 Premiun Edition

Text output: On |Page mode: OFf [Braphics autociear: On (Mouse wheek Fast [Units: mm |Central reference ray made. wavelr: 1 (0.588) [Aper div: 17.03 7

=
o Command:

<= (Command (Basic) Style

useful for

No menus or toolbars
command line input
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Graphics Windows

« Up to 32 Windows with Optignal Toolbars

R UW 1 - Lens Drawing *

« Extensive Vector Graphics

Limited OpenGL graphics

Clipped viewports

Zoomable (mouse wheel support)
Mouse events

3D drawing functions

Fully resizable /
Black or white background
Right-click support

/

BHG<=a@lll«

3-5 Telecentric projection lens
FOCAL LENGTH = 23.02 NA = 0.1786

UNITS: M
OES: Betensky

Internally generated lens drawings

— Shaded contour plots

For use in UA Opti 517 Class — All rights reserved -Lambda Resea_
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Text Windows

=Twi- W[ S

® | | t 2 | t W. d B Len Spe Rin &pe Wav Puc Abr Mrg Chf Tra Ref Fan Spd Auf Var Ooe e
p O eX I n OWS Pus Put Chr Sei Fif Zpes Z3pa Zzen Zohr Zeei Zfif

Spz Wl Mtf Psf

*LENS DATA =]
Mo name
. SRF RADIUS THICKNESS  APERTURE RADIUS GLASS SPE  NOTE
—_ Optlonal tOOIbarS 0BJ 0.0 1.0000e+20 1.0000e+14 ATR
AST 0.0 0.0 1.000000 AS ATR
. . . . ™s 0.0 0.0 1,000000 5
— Variable width, variable height e smoces
) SRF GLASS RNL RNz RNZ WNER, TCE
o ATR. 1.000000 1.,000000  1.000000 0.0 0.0
1 ATR. 1.000000  1.000000  1.000000 0.0 236.000000
. z IMAGE SURFACE
- Up tO 2000 I|neS *PARAXIAL SETUP OF LENS

AFPERTURE

Entr i 1.000000 Image axial ray slope: 1.0000e-20
Mum. aperture: 1.0000&-20 F-rumber: o.o
— preadSheet Bu er upport Image Hnum. aperture: 1.00008-20 warking F-number: C.0000e+19
FIELD
Field angle: * E,7295e-0% Object height: -l.0000e+14
Gaussian image height: -1.0000e+14 Chief ray ims height: 0.0
. . CONIUGATES
Object distance: 1.0000e+20 srf . .
- I zlght_CIICk Support Gaussian image dist.: -1.0000e+20 srt Prfnthndow
overall lens length: 0.0 Total Print Page Oe+20
Fara<ial magnification: 1.000000 srt Frint Selection
OTHER DATA
. ] Entrance pupil radius: 1.000000 SH Copuwind » b
* Wind Clipboard SuppOrt ——————rm———— C
In OWS I Oar u O Lagrange imvariant: -1.0000e-06 Fetz Copy Fage P hoe+4n
Effective focal length: 0.0 [EappEelEatinn
SPOT DIAGRAMS
. Aperture divisions: 17.020000 Gaus! Save Window As
- P T | mod R ¢
age Or erm|na O e ¥ 1/eA2 entr. irrad 1.000000 Y 1/ Save Page A, oooon

Saye Seletiar e
PI | L

° Optlonal Command EChO 1.00002-20 -1. 001 ?:;kgrjg?dcolm e-06 .
v FPage Mode R : él
— Text Output on/off preference co

Remave Toolbar
Clear Window and S5 buffer
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Spreadsheets (SS)

* Drop Down from Command Line - Fixed -~

— Fixed width, variable height
— Keyboard or mouse navigation
— Lens data spreadsheet

EEE Surface Data H = E

of Command: o }"’
5. 5494520120229 = s

X =

EHE

-Istpllw elength |[ Field Points || variables || Draw on || Group |[ Wotes | ~|
=3 Ef1 a3 &

has 2 sections for cell navigation

« Data Entry 2
Command line
— List cells

AST . N 9.8445
-122., 000000 : o.5o0000 ] 10.18130% ATR. D
o.oo0000 ] s.ooo000 [ ] 10.221590 5 | SK16
3] -so.ooo0o0 [T ]  z.zo151s [W]  10.408462 Atk ]
=-50.000000 10.25746 SK1&
atr [

00000000

IDEDDDEI§ é

1 T ENs nglet with compensator --- 1 of E
Ent beam radi |—| eld angle 7. 4 Primary wavin 0.587560
SRF ADIUS ~ THICKMESS APERTURE RADIUS A
000000 D oo [ ]| =zo.7esazz A D
UUUUUU [ 20 SK1E ?

Variable

'

Direct specification

p  colves (5] k

— Button pop-up menus

« Spreadsheets Invoke Other
Spreadsheets

— Multiple spreadsheets organized in a
stack on top of each other (FILO)

— Revert feature for lens data

For use in UA Opti 517 Class — All rights reserved -Lambda Resear'Co_
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Command Line

« Command Line is Windows ComboBox
— Max length is 256 characters

— Drop down list is history buffer
— Click drop down arrow:
— Press F4 on keyboard
— Press Ctrl + PageUp
— Press Ctrl + PageDown

QMmand:

— Windows Cut/Copy/Paste support by right click only
— Keystrokes forwarded from Graphics & Text Windows
— Need to click on command to edit

Enter ':::5?
« Press Enter, Escape or click button: Escape 4
Help ?

For use in UA Opti 517 Class — All rights reserved -Lambda Resear':_ ﬁo



Command Line Syntax

C-compatible or free form

— draw_rays(0,5,-1,1,0,0) ¥ rawravs (o,5, 1,1,5,0) il 2
— draw_rays 05 -1 1 Z =

Long or Short Form

— drr and draw_rays are the same command (aliased)

i
g
g
5
a3l
H
-
4
SE N

] =

Forced Prompt Operator (?)

=l zey
=

=0 x &

— ? Causes prompts

ﬁ!}")

=5 X &
-

for all missing arguments

2 =
=i

+ Calculator Mode
— 2+ 2 ENTER produces “Result = 4" message
— SmartCells distinguish between commands and values
— Named registers - OSLO Lens data (RD, TH, ..etc.)
— Symbolic input: a=Pl; 2*PI

For use in UA Opti 517 Class — All rights reserved -Lambda Resear'Cd_
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Databases — Lens and Glass

« User configured SS for 2D array data entry

&8 Database ..\Gla

. D e Database ..\lib_public_prm.cdb &
| Fie Lens Evaluale Oplimis Toleance Souice Took ‘Window Help = e x |
New Lens. Clik 4 IE ormard | 2
T Lo » % schort_zo00.q1c Glass catalog
Sl ? [(Penu | [GTassName | [Tndex(d) | vnbr (drFe] [Dens 1 ty] [dn /] [T<E] i ttan] [Cos t
Sl [oireecionne [ aene stumrso] [T 1723728 38.11 .31 6.4 54 0.800 0.0 540 24515
TR [menu |[LENS 10 r2 1.620040  36.37| 3.61) 2.8| 82| o0.382 0.0 a420|1m2:
TrpeLers Fle v L Eneneron ittt i = 1.60320  38.03  3.47 3.0 80 0.984 0.0 450 10127
Expart Lens to CAD s S L 710,00, D0-0lFRISM 1.501371  S6.41  2.5:¢  2.7| 65 0.384 0.0 470 10111
d\DDE”DE‘EEWﬁ Demo Triplet somm F/4 zodeg osLo 7 0.12 20.0 COOKE TRIPL T EPEET] T35 e.s| sz 0.5 o FoT ST
[ Joigital Triplet 1omm f/2.8 20deq 0SLO 7 0.18 20.0 COOKE TRIPL T
P e Laser diode collimator smm .5 Na DSLO 7 0.00 0.0 OBIECTIVE ] T [_ o]
:f: i:ﬁ';?”” (IR | bert Grating wonachromator g GW 1 - Ray Intercept Curves Analsis * 1.670030
bove prism Bcamle YT it
Phint Graphics Window. Penta Frism T Ao Tght 5. 1. 605683
Page Selup (Graphics). 2] Germaniun-0i ffractive boublet fzm SR | 1652240
Save Graphics As. 100mm Ff2.8 Gradium Doublet Teepecal:
Rt = D pickup gradient-index lens 7—¢q§ o
[[2z JGrin rod for demonstration [ R e
1 TRIP.LEN 11 i =
2 I\BETENSKY41-2 compensator len SRl 08 e
3 IBABETENSKYA35 telecertiic.len 5 | g i & w
4 C:\My Documents\0SS upport\MikeSimpson'Ref Lens - Rad 5.len ——
Exit p ' e

« Configured for CDB files ]t -

o s m

— Supports CSV and related files = oo =ummes=
— Over 1000 lens designs available including examples from Warren
Smith, Arthur Cox, Ellis Betensky and Bruce Walker
* New Features
— Fixed width, horizontal scrolling
— User programmable with callback buttons
— Limited keyboard support
— List support

)
18 ape 11
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Slider Wheel Window

WA
- Special Window for 32 ey i

. Generate Emor Function  #
Sliders e

Operands...

Yaniables...
Sliderwheel Design...

— Combined with data entry

[terate:..
S p read S h eet Sdvanced W ptimization. ¥
Optimization Conditions. ..
Suppart Routines 3
- Supports mouse Wheel BEIES<zza:@N == @Ek%é%f%i@%?ﬂllll ¢ ==
— Variable range for real data
b L

— User programmable @

— Integer, Real, Real Fixed, and s somm | r ol septs =

List data types E— = -

For use in UA Opti 517 Class — All rights reserved -Lambda Resea_ @O
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Sliders

@ Double Gauss, 50mm f/2 20deg [dblgauss.len] - OSLO Premium

File

Lens Evaluate Optimize Tolerance Source Tools

Window  Help

BIREERO@SE S5 w0

I Surface Data

o
x|

2 Callback not implemented

Ent beam radius

Gen |[_setup || wavelength |[ Field Points || vari

Lens: Double Gauss, 50mm f/2 20deg
12.500008 Field angle

Zoom

20,

B

SRE RADTUS
081

[=] 24800000 ]

[=2] 218.323587 ]

[=] zo.240000[]

[a] -ss.075776 ]

13.490000 ]

THICKNESS

7.000000 ]
0.500000 |
8.000000 ]
2. 000000 [
2.g80000 ]

APERTURE
0.000000 | 1.0000e+20[ | 3.6397e+

21.0000(
21.0000(
15.0000(
15.0000(

2.5000(

=a=]

G 32T

GwW 3

FE A

=Twie

B Len Spe Rin Ape Wav Pxc Abr Mrg Chf Tra Sop Ref

B Slider Window \\
oV 3 0.049164 4l = +| Stepooot
oV 4 -0.021288 4 B | stepoont = ¢ mm

[Text output: On [Page mode: Off [Graphics autoclear: On|F-number. 1.999

FIELD: 5.73e—05deq
IMAGE NA: 0.224 EFL: 50.2mm

WAVELGTH: +:0.588 4:0.486 0:0.556 um RAY TRACE ANALYSIS

QsL0
23 Aug 16
04:47 PM

Multiple sliders can be attached to multiple variables with two displays showing the
effects of changing the variables as the sliders are manipulated




Catalog Lens Window

Graphical Database for Stock

Lenses

— Scrollable lens list

— Automatic drawing of lenses

— Database sorting for focal length,
diameter & part number

— Range selection

— User configurable

g5 Suiface Data

o
x|

=l

B

Gen |[ setup |[ wavelengrh |[ Field poinrs |[ wariables [[ oraw on [ Group |[ Notes =]

Lens: Demo Triplet Somm /4 zodeg Zoom 1 of 1 |Efl  50.000541
Ent beam radius  6.250000 Field angle 20.000000 Primary wavln  0.587560

SRE RADIUS THICKNESS APERTURE RADIUS GLASS SPECTAL

081 0.000000 ] 1.0000e+20 ] 3.6287e+13 ar ] [

2t.z50000 | z.oooooo ] 6.500000 SKLE —

— esoooo [ ] e.o000000 ] 6.zooo00 R awr ] [

.2so000 ] 1.o00000 ]  s.oo0o00 [T F4 —

6.000000 [ ] s.o00000 ar[] [

2.000000 [ —=r ] s —

i

|

Catalog Lens Databasze

10

»

15.000 |-
1%.000

1%.000
20,000
20.000
20.000
20.000
25.000
25.000

c 0|

25.00

080554 Cul
oo [

Easte

Insert Before
Inisert After
Delste

Reverse

Ireeert

Element Graup
IS EGUErtE Ereun!

|

=

Edmund Scientific 25.000
Part: ENAC45422 Diameter: 25.000 25.000
EFL: —-75.000 Thickness: &.560 25.000
f X P
Lens Twpes: (2 singlets & Doublets ¢ others
Sort Byt ) EFL ) Part
Central ET1: S0.000000 +/- Range: [ 5.0000e+03

Central Dia: 20.000000 +/- Range: [ 200.000000]

Catalog:

EDMUND Fart Mame: | EWNAC45422

For use in UA Opti 517 Class — All rights reserved -Lambda Resear':_
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Printing

Print [ 7] ]
e Uses Standard Windows Drivers  Prvte
Mame: IHPLaserJet4DDDTN FCLE j Properties. .. |
— Standard printer selection dialog box e
ypE: azerdet 4000 Senez PCLE
wihere:  hpd000
— Standard page selection dialog box Comert I Pt ofi
r— Print range Copies
& 4 Hurber of copies: m
. € Fagez  trom i)
e HPGL Graphics Output airn el el I coe
e Other Protocols Supported Through Windows ek _| ok ]_Comed |

— *.wmf, *.emf files
— *.bmp files for OpenGL output

— Limited postscript support through
Windows

e Lambda Research does not provide device
support

For use in UA Opti 517 Class — All rights reserved -Lambda Resea._’ @o



_ﬁ- T p—

U.5.PANS 48365603E% 1 of 3

[rRTET—
AN 1 0 10 o
Wienia

0 30 2 s
oetemsky s as . o 2 ¥
Btengiy 7 om momm T 5
2-4 WP Real rays setensvy 7 a0 3 me | 1
T5E] 3-8 -smimizes ity TSt St
ez | el e o (e s Jeeersy 14 nm0 300 3
CEER] 4t o partiatly correctes

Brvensiy
CEEEl 45 rur fixes varred ety 1 0 s
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TV Zoom Lens
NA = Q. 1786

:«41-4 \r‘\'o

5 04 6.0 ceNEE
€ e .8 NETR
s oas 0.0 e T
|

P wsoy
o

PV 02,41 RS 2185 PV T2 RE NS
1 ; zoom {inder
3-3 rec W\ﬂﬁ.“[ 10N =

BT 1= 0. 5376 i
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Using the Browse Lens Library — over 800 optical systems

Get_startup_option >

Would you like to
(" Statanewlens  Openthe cumentlens  Openan existinglens ™ Browse the lens librand

Show this dialog box at startup?
* Yes 1 Mo

QK | Cancel Help

@ Hubble space telescope [hubblelen] - O5L0 Premium

File Lens Evaluate Optimize Tolerance Source Tools Window Help

BisEBO@EES:

=

T Databsse (SE =] =ewi e
f Command: = B G » B8
x ! =limes | [ Field C.11 deg
2 =g 0.5 mm ASTIGMATISM LONGTTUDTNAL CHROMATIC
Lt S % T+ {mm) SPHERICAL ABER. (mm}| FOCAL SHIFT (rm}
[[Prescription |[ Spot Diagram | A
[ienu | Lens 1 |EEsToE o, '
1 | Anamorphic Bravais objective 2x 05LO 5 0.05 -2.9 OBJECTIVE . , ,
EAna'norph'ic prism assembly MGR 7 0.00 0.6 PRISM % 4\4\'—
[ = |pemo Triplet somm f/4 zodeg 7 0.1z 20.0 COOKE TRIPL |
[ 4 Jraser diode collimator 8mm .5 NA 7 0.00 0.0 DBIECTIVE WEHOCHRMATIE SYSTEM
Ebert Grating Monochromator 4 0.14 -0.0 DIFFRACTIV® |
& _|Grin rod for demonstration osLo 3 0.2% 20.0 ROD Field ©.077 deg
7 | Hubble space telescope o0sLo 4 0.02 0.1 TELESCOPE G.5 mm L
5 IR Fisheye Lens T.Jamieson 10 0.71 45.0 I.R. FISHE* o - o .
[ 2 Jraser communications system osLo 8 0.25 0.0 OBIECTIVE B s et
[10 [ He-ne f/2 doublet focusing lens OSLO 5 0.25 0.0 OBIECTIVE +"‘1‘Hq+
248 } | ] DISTORTION (%)
Magnifying glass &X 05L0 4 0.10 2.5 OBJECTIVE +‘+‘H+++ '*‘“—4—_4 o1 o
12 Mnnn auartet 1nomm £/3 15den 0s1 0 9 0.17 15.0 ORIFCTTVFE N
=i e =
B Len Spe Rin Aps Wav Pxc Abr Mrg Chf Tra Sop Ref Fan Spd Auf ANTS %
13
*LENS DATA ¢.5 mm .01 6
Hubble space telescope
SRF RADIUS THICKNESS ~ APERTURE RADIUS GLASS SPE  NOTE LATERAL 0OLOR: () 3
0B3 -- 1.00002+20 1.9193e+17 AIR ;L
1 -- 4.9061e+03 1.2094e+03 SX AIR =+ s
MONCCHROMATIC SYSTEM
AST -1,1040e+04  —4,9061e+03 P 1.2000e+03 AX  REFL_HATCH  *
3 -1.35808+03 6.40598+03 5 150.000000 REFL_HATCH = UNITS:
NS -- -- 110.578530 5
;;&EE.NEJ;C';;OB EFL: 5.76e+34mm ibule S tEIESCOpe ZJTLO 18
a0 : 5. 7BeH L)
WAYELSSTH: +: 0 632 um RAY TRACE ANALYSIS 05: 14 PM
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INTERACTIVE CATALOG LENS
DEMONSTRATION
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Open OSLO - File New > Select Catalog Lens

File new *
New file name | TR
File type Catalog Lens Database »
{+ Customlens { Cataloglens { Perfect lens 43.160 A
44,665
MNumber of sufaces 1 47.175
50. 000

000000 : ] =f t 50. 000
50, 000
0. D000 50.000
0. 050000 e b 50.000
50, 000

10 rmm

@ Mo name [untitled.len] - OSLO Premium 50, 000
File Lens Evaluate Optimize Tolerance Source Tools Window Help 50. 000
n e = 50. 000
2] 5 @ = 1)
)| 3 = e 28 @ e i 2 e @ W3 — 50. 000
55 surface Dota =@ = Part: MGD1LSX017 Diameter:  22.500 50.000
JtSP'eadSheemD”m B bl EFL: 50. 000 Thickness: 4,080 Q. 000 W
v, S
: X
[Gen |[ setup || wavelength || Field Points || variables || Draw off || Group || _wotes | J ?
Lens: No name Zoom 1 of 1 EFl 1.0000e+54 Lens Types: {::' Cem Dblts {::' Others
Ent beam radius 1.000000 Field angle §.7296e-05 Primary wavin 0.587560 "
SRE RADIUS THICKNESS APERTURE RADIUS GLASS SPECIAL 50rt By: @ EFL D Diameter D Fart
e i R e R Bl central EF1: +/~ Range:
E::» T click on S$S and select Insert Central Dia: +/- Range:
e Catalog Lens catalog: | MELLES_SPH | Part mame:
il Insert Before
Insert After
Del 1
Two methods to open the catalogs of lenses in
— Reverse
% Inver |?H_E|_| =
B t Tra Sop Ref Fan Spd Auf Ve G - OS LO .
Element Group I . -
Mon-Sequential Group H
el 1- File New and Select Catalog Lens
Insert Catalog Lens... . .
e m— 2 — Open a new lens, right click on any surface
Scale Selection...
: column and select Insert Catalog lens

For use in UA Opti 517 Class — All rights reserved -Lambda Resea_ @



s e

[
B AN T i |
Within W oB.ae 36,9 20 | \ ‘
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el W meal rays

setanay
1-3 np-optimzed setensy
[ o mrm e (R

> \
Tt n0
teas

:,.Lréz' i‘g‘_..s“"

TE5] -+ oor parmianly comracten patenty
Taaales re rices warrst oy
o] v.5.pars ameserzon Lof 10 btk
s oo 100

el o 10
Fae i 10
«

P u;‘\m

B =nem@ls Tinder A
3-3 real imoge zoom LA
WGULAR MACHTF TCATION = 72

PV 92,41 RUB 21,8

= 1 = 0.5576 @
0P 1252

15, X
\g /128 hoer e 0Ly,

3Field P

Introduction to Command Line,
Setup and Preferences
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Introduction

* Installation — Setup
* User Interface * Preferences
— Windows Topics ° Fonts
« Menus * Mouse
« Toolbars * Keyboard
* Main Window Types
— Graphics
— Text
— Spreadsheet
* Other Windows
I — Command Line I
— Database
— Editors
— Slider Wheel
— Catalog Lens
— Printing

* File and Program Information
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Introduction

* |nstallation

» User Interface
— Windows Topics

* Menus

* Toolbars

* Main Window Types
— Graphics
— Text
— Spreadsheet

* Other Windows
— Command Line
— Database
— Editors
— Slider Wheel
— Catalog Lens
— Printing

— Setup

* Preferences I

* Fonts
* Mouse

+ Keyboard

File and Program Information
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Preferences

* Determines Program Parameters
« To Show Preferences: =
— See File>>Preferences>>Show

Preferences
— Type shp on the Command Line e
 To Set Preferences: e

3 IB\BETEMSEYY1-2 compensatar.len
4 TRIP.LEM

— See File>>Preferences>>Set Preferences
— Type stp on the Command Line

* Values include int_pref, real pref,
..efc.

« Saved in .../private/oslo.ini

* Look up “Preferences” in on-line help
for complete list
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Fonts

- Need fixed and variable spaced =
fonts Choose fixed-width font for H; - 7] ,EELTCS :
* Fixed Fonts 0 Foe d I;ﬂ z ﬁ @EZEZ?
— Spreadsheets, text output i::iﬁ e . E g i
— Maintains columns
- Variable Fonts e
— Messages, prompts = -
— More readable ot :
« Change using OSLO menu item & ' T
Windows>>Choose Fonts il o | |
— Note: 2 dialogs open sequentially. Try, A - _
« Variable: MS Sans Serif - 8pt or [ o
* Fixed: Lucinda Console - 8pt e
— Don’t use > 10pt (formatting problems) == -

For use in UA Opti 517 Class — All rights reserved -Lambda Resear'Co_
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Mouse

» Left click selects

* Right click pops up context menu
* Double click updates graphics

* Drag

— Zooms graphics (Marquee box)
— Selects range in spreadsheet, text output

« Shift-click changes input mode in
spreadsheet

* Wheel zooms graphics, scrolls SS and
sliders

« Slow mouse wheel preference(simw)
— 1 event/notch when on, 3 (typical) when off

For use in UA Opti 517 Class — All rights reserved -Lambda Researﬁ_ @Lo



Keyboard - Shortcuts

« Text keystrokes sent to Command Line:

 CTRL + Arrows: zoom graphics

 SHIFT + Arrows: select text output

« CTRL + PageUp/PageDown: scrolls history up/down

 TAB & SHIFT TAB navigates dialogs and spreadsheets

- Keyboard arrows navigate SS but don’t cross fixed boundary
* Windows intercepts some keystrokes (e.g. F4)

* Define special keystrokes as “accelerators”
— See “Other Accelerators” menu in a_menu.ccl
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Status Bar
 Visibility set by preference shsb

* Choose Menu item:
Window>> Configure Status Bar to set items

* |tems are pre-programmed for CCL
— Select pre-programmed items from the list

— Use Set_Preference (stp) command to set value
« Strcpy(Astr, “My item”
+ stp(sb04, Astr)
* “My item appears in field 4 of status bar.
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Serenshy

et
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1-3 np-optimzed

aetemiy
serensiy
oz | et e e i seversiy
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e
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Introduction to the
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Introduction

Installation
User Interface
File and Program Information

— OSLO File System

* OLSO File Hierarchy
 LEN/OSL Files

| » CCLICCX Files |
« CC Source Code Files
 SCP Files
- CDB Files
* Other OSLO Files
* Import/Export Files

— OSLO Functional Flow
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OSLO File Hierarchy

— > C:\Users\Public\Documents\OSLO7 Premium

— AMO ge begin_guide ! User Folders ! Data Folders

AppMan Objects Global Explorer Help
Public Data Premium Only
— BMA L IMAGES

User Interface Bitmaps GE Images

— DLL
OSLO Dynamic Link Libraries
Premium Only

— GLC
Catalog Glasses

— LMO
Manufacturer Lens Files

— MOV
Movie Files

For use in UA Opti 517 Class — All rights reserved -Lambd_ m




Public Folders

C:\Users\Public\Documents\OSLO7
Premium\public

S

Einc ‘_ L ‘_ L XSOURCE
ELEM LIB vendor

DEMO

Include Files Source Image Files

Demostration Lens Aperture Data  OSLO Lens Library Vendor Data
by Edition
APER L BETENSKY - GELTECH
EDU L Zoom — GRADLENS
Light Promium | COX L LIGHTPATH
Standard Book — USPL
Premium _ SMITHGEN _ OTHER
B Book
ANITR2D TOOLBOX EDMUND
DLL — WALKER MELLESG
NONSEQ Book OPTOSIG
SPINHOYER
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Private Folders

| AMO tutorial
ppMan Objects User includes Sample Database

>

| GLC
Private Glass
Catalog

| IMA
Bource Files

| MOV
User Movies

|1 OSw
Slider Files

y




OSLO File System

 Public and Private Directories
— Public Files marked “read-only”

— Private set by OSDATA environment variable in win.ini
— Also uses “current” LENS and TEXT directories

 Special File Types Y |
— LEN or OSL Loak in: | 3 BETENSKY =] « @ ck E-

1 Premium @1-5 improved. len @3-1 real finde
5711 single element len @ 21 np singletz len @ 32 mod-1 re:
57 1-2 compensator.len @ 2-5 patent.len @ 3-4 mod real
57 1-3 primaryabs.len @ 2-6 np-mod1.len @ 3-5 telecentr
5714 primary min.len @ 2-8 ogino 35-70.len @ 4-1 n singlet.|
03115 fix brl len @] 29 ta 28-70len 74-2 pn singlel

— CCL
- CDB 'F‘-.I & I

¢ U SeS M Od ifi ed Wi n d OWS Files of type: ILeng files [*.len;*. osl) j Cancel

Dialog Box:
< Library Directaries: Frivate | Public

(set under preferences)
— SCP

PJLE.
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LEN/OSL Files

« LEN is current format

« Text files containing optical prescriptions by listing
commands

//[OSLO header line

LEN NEW ...more lines... END
CFG NEW ...more lines... END
Miscellaneous data lines

VAR NEW ...more lines... END
RST NEW ...more lines... END
OPE NEW ...more lines... END

* Use literal or symbolic data
* Insert one lens into another

(lens surface data)
(multi-configuration data)
(operating conditions)
(optimization variable data)
(rayset data)

(optimization operand data)
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CCL/CCX Files (1)

CCL: Compiled Command Language Similar to Java

File Name not significant
— Scanccl.ccl used from the command line locates commands
— File prefix groups commands

« All CCL Files Compiled to *.AMO
— AMO: AppMan Object file

« Automatically Compiled with OSLO Editor

* Incremental Compile/Link

* “Private Files” Outrank “Public Files” in Usage Order
« Use *.CCX for In-Process Files

For use in UA Opti 517 Class — All rights reserved -Lambda Resear'C_ ﬁo



CCL/CCX Files (2)

* File Locations of Special CCL Commands

— Argument definitions & globals: a_global.ccl
— Strings: a_string.ccl

— Lists: a_list.ccl

— Menus: a_menu.ccl

— Toolbars: .../inc/a_toolbar.h

For use in UA Opti 517 Class — All rights reserved -Lambda Resea_



SCP Files

« SCP: Star Command Procedure
— Not as efficient nor as powerful as CCL

— SCP is meant to be used to create simple scripts

— SCP is a subset of CCL
« Search Order

— Cmdname:filename
— Current file, if specified
— Default.scp

 File Format

*cmdname

ccl command line statement;
ccl command line statement;

- etc. -

*cmdname
ccl command line statement;
ccl command line statement;

- etc.

For use in UA Opti 517 Class — All rights reserved -Lambda Resea_
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CDB Files

« Compatible with Excel, ...etc.
« Used for OSLO Lens Library, Source Database
« Edited with OSLO database spreadsheet

« Format is “Delimited Data” (*.CSV, *.TAB)

with a Readable Header:

,=Ibc...cdb6%4d%9.3t%9.1%9.31%-6.6t5%9.1f%12.6f
BK7=1.5168,SILICA=1.45846 \tlex_6,,,,,,.,,,,

LenslD,Radius1,Thickness,Radius2,Glass,Diameter,Focal Length
1,25.95,4,0,BK7,20,0.0
2,-184,2,184,SILICA,30,0.0

3,21.577,6.9,-21.577,BK7,20,0.0

...more lines...

For use in UA Opti 517 Class — All rights reserved -Lambda Resear_
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Other OSLO Files

« *.GLC:

« * LMO:

o * TGL:

« * OMD:
« * OCD:
« * MOV:

« " INT:

« * AMO:

Glass Data

Lens Module (catalog lens)
Test Glass

Coating Material Data
Coating Prescription Data
Movie

Interferogram

Appman Object Code
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Import/Export Files

* Import Data From
— Code V (*.SEQ)
— GENII (*.LNS, *. LEN)
— Sigma (*. DAT, *. LNS, *. LEN)
— Zemakx (*. ZMX)

« Exportto CAD
— IGES (*.1GS)
— DXF (*.DXF - 3D only) Tested with AutoCad & Design Cad
— IGES support for Mastercam (COM Opticam format)
— STEP — All Surface Types

For use in UA Opti 517 Class — All rights reserved -Lambda Resea_
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OSLO Functional Flow

* OSLO is built on CCL

* OSLOxxxx.exe
(all versions of OSLO):

— Include library routines
(from C)

— Loads compiled CCL routines
(from AMO files) for execution

Command Text
Line ‘ ; Windows
S ) Graphics
OSLO Windows
Commands (C andAppMan)
DLL Public Private
Premium AMO AMO
C CCL
Compiler Compilers
G CCL
Routines Routines
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Lens Drawing

« Drawing Conditions
— Location of drawings, space for ray trajectories
— Appearance (rings, spokes, apertures, mirror hatching)
— Rays to show (object points, fans, etc)
— Rays are not same as field point set or ray set

* Drawing Types
— Plan View (Strictly 2D, not a projection)
— Wire Frame (3D, uses color for surfaces)
— Hidden Line (also incorrectly called solid model)
— Shaded (Uses OpenGL)

- Zoom Drawing
— Shows all positions
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Glass Database

e Use glass database to help
choose appropriate glasses

— Draws glass map
— Sort on any glass data
e Be wary of glass availability

— Glasses in center of map
not necessarily cheapest

— Vendors working on new
glasses

e Temperature and thermal
expansion data included

£== Database .Mglass_schott.cdb < Surface Data

of fm
schott.glc Glass Catalog -
Menu |[c1assname |[Index(d) |[vnbr (dFc][pensity][dn/dT][TcE][¢mittan][cost |[Hardne] chemc
1 | BAFNE 1.583000 48. 45 3.17 3.0 78 0.930 1.0 540 20221
[z |F2 1. 620040 36.37 3.60 4.2 82 0.985 1.2 420 10121
[ 3 |FzHT 1.620040  36.37  3.60 4.2 82 0.991 0.0 420 10121
[ 4 |Fs 1. 603420 38.03 3.47 4.3 80 0.982 1.8 450 10122
[ 5 |Fks 1.464500  65.77  2.27 -0.2 82 0.985 0.0  3B0 23521
& | FKSHTI 1. 487480 70.47 2.45 -1.1 92 0.937 0.0 520 21422
PGW 1 = =
:WEI%%?@HHH i
nd-vd Diagram — schotti.glc Glass Catalog
[ | , , : , | | :
i *LaSF3S i i
777777777777777 : : ‘P{SFEE
'NéSFES
qcm *P-5FE7
HELASF3IA :
'N»LASF‘H: ‘N«LASIMJ e
77777777777777777777777777777777777777777777777777777777777 n-LpsFa ‘N_‘,}?égﬂm N LaSFASHT. EFEREHTLLT
1.8 SN-LAFET en-LaF3s + HSIEE 1
~H-LaF 34
= P U S IS ST ST LKA H-LAF3T L— apdh
2 & S
el =LAk AT TN-KZFSE a
WLAE N-LF3
L e etitstacs T, ey
N-LAKTZ . L, s EES
1L BB mmmr o AT L WL 5
B USSR SO PO SR ; ::(T.H'M‘ﬂ;« e ST it T
: mme BEARNS T ke
Lacrr M
1. B oo st lea INEIE L FIHTT.
NP ~P-KED . ,b:i:z “hiF
FTY=] SR SRS N MBI e R LAY
~ReBEL
+FK3
LT R
145 75 7a E5 £ 85 G & En) 35 3 75 7a 15
vd
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Element Drawing

« 1SO 10110 Compatible
— Tabular format
— Default SS shows ISO standard values
- Enter Data, Drawing automatically produced
— Tolerances
— Fabrication data
« Singlets Only

e Portrait Format Preferred
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Evaluation Setup

Set Current Object Point
— Automatically traces reference ray
— Use caution in interpreting, not always used
- Set Current Wavelength
— Used for analysis as default, indicated if not 1
« Set Current Configuration
— Sets configuration for analysis
« Autofocus
— Adds shift to image surface
* General Conditions

For use in UA Opti 517 Class — All rights reserved -Lambda Resea_
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General Conditions

— Evaluation mode, Aberration mode

— Units, OPD in waves

— Ray aiming type, Ray aiming mode

— Wavefront reference sphere position

— Symmetry State, Aperture checking

— Solves in alternate configurations

— Zernike polynomial reference axis

— Global reference surface for ray data

— Evaluation z-axis

— Source astigmatic distance

— Temperature, Pressure

— Use equal image space ray increments
— Polarization Ray Trace, Calculate diffraction efficiency
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Paraxial Analysis

« Paraxial Constants

— Pxc, Pxs commands
- Paraxial Ray Trace

— Pxt (in either XZ or YZ plane)
« Zoom Setup

— Data for all zoom positions
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Aberrations

« Aberration Coefficients
— 3rd 5t 7th GA
— Seidel Pupil aberrations
— Buchdahl Fifth-Order
c M1 -M12
* Intrinsic/Transferred contributions
— 3 order axial gradient contributions
— Transverse, Angular, Unconverted, Wavefront (3')
« Zernike Coefficients
« Zoom Group Sensitivity
« Aldis Theorem Contributions

For use in UA Opti 517 Class — All rights reserved -Lambda Resea_
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Reference Ray Definition

Aperture Stop

Entrance Pupil

I

T

Reference Ray

i
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Image Evaluation

« Ray Analysis

« Spot Diagrams

« Wavefront Analysis

* Point Spread Function

* Modulation Transfer Function

« Through-Focus MTF

« Slider Wheel Interaction with any Analysis
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Ray Analysis Examples

Flald 2 dap

SLIE

Flald- Xt ATIHATEN LONEITLGINAL CHRDWATIC
S %7+ (] |SPHERICAL MEER, hrm)| FOCAL SHIFT fmm)
oy
N2 E£
A
Fleld W.3 I;E o4
r g AT (
-1 1 -l El -1 h al
_1DISTER'|:D]| 3] N

'T.-‘W = :
s,

Irﬁ

—1.Qm ij e
FIELD: ey CEMO TRIFLET =17
IMAE WA 0125 EFL; S0mm 12 Mpr OF
WELETH: +:0.588 =i 0, 465 o; 0, B8 pm RAY TRACE ANELYSTS 11:1l:Ith

e1m SETRATIN ot TR | o R Gy
%—4 I-——ﬁLI /
Fleld W-.3 I‘EE&‘I - < oa
-1 1 A El 2.1 h Al
I—E,-—-A iy _1|:I12:iILl1IJ.I.N [£3] R
f———
L erm i Ray Intercept
| .om i
FIELD: 2wy DEMO TRIFLET L
AL, 100 0:0.4B6 ;L0858 RAY TRACE AMALYSIS 1o wd
0.1 .
w_|  Chromatic
—  O.ee_ .
E 7| Focal Shift /
= 0
0wl
= =, 025 _
,_IS_ -0.06-
0075 _
-0l I SR S S I |
as 0,45 ] @55 0 e 0. a7
‘Wavelength [um)
DEMG THIFLET Lo
CHRCMATIC SHIFT 12 or

Chromatic

+——H0.60
XL T
et ], B
ol 00 Ral. Halgst

_— D, b
£*| Lateral Shift
z m
o
[
m
B-0.0075_
=1
0,005 ! ! | ; !
o4 .45 o5 0,58 0.6 Q65 a7
Wavelength [umy
DEMG TRIPLET wmw
CHROWKTIC LATERAL SHIFT 2. bor
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Spot Diagram Example

Spot vs. Field & Focus

Single Spot

e = e o FBY & FEX O REFHT ©
SPOT DIAGRARM FOCUS O INITS: mm
.05
GECRETRICAL GECMETRICAL
R4S R SIZE RM= v STZE
0. GOFOTE 0. OGS0
OIFFRACTION GECMETRICAL
LIMIT Rz ¥ SIZE
0, QOZBE2 0, Q0501
=005
. — 1
Spot and OPD vs. Field
- B

[ENaS]

.02

C.01

— RMS Spat Size

{hae) 0d0 SR — —

| |
o,c G2 0,4

| |
[N 0.8 1.4

Fractional Object Height [FEY)

FULL FIELD j‘ .l. i - :
0deg '**—‘ "é" ”i’ "i* ‘%’
0.7 FIELD % % i i S
14, 3deg q
CH—AXTS o e 3
Odey & > 3 ¥ #* #* ®
-0, 1 —1.0% n] .03 o1
FOos SHIFT
FPCT STE 4 FUCUS SHIFT: LHITS = mm OFT4S TRIFLET =17
W1 0.5 T Aot W3: D.068 EPOT DIAGREM ANALYSIS ek v
Single Recipolar Spot ||~
Cutr o oyl CEMTRLID
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Wavefront Analysis Examples

FULL FIELC=Z0de 0.7 FIELD=14.Jdeg

i
—

Oh-AxTS=0deg Fd

m !i

¢

—
- y
e ——

Wavefront vs. 2D field

1 L - ¥
——

0.7 I »\‘\
Wavefront vs. linear field = _ :
e i ’ . , l' '
] - h _d .
Yl FiD n nF 1 NFED
EMETH 1 = 0, B8 7% 1m OEM TRIPLET =17 Full Fiwld = Mdeg OB TRIPLET =17
5 FlaLd Bt ¢ Ton ey sira . WAVEFRONT ANALYSIS bl v T o s e et 20 WAVEFRONTS e
DEMD TRIFLET FBY 1 FBY G Wyl lam) = DEMD TRIPLET FBY 1 FBY G Wyl lam) =
WAVEFRONT DONTOURE — W' FoOcs O 0, BRYES IMTERFERZGRAR — Wi Focs O 0, BRYES
P-¥ OPD 2,563 s
Fits OFD O, 44359 7 {BEAGE
¥ SHIFT 0 v
YOSHIFT —q,cha0ag "
¥ OSHIFT g y Py CPl
I 2,983
 SHIFT s CRD
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Wavefront Contour  Yalley Interferogram Analysis
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Point Spread Function Examples

PSF Report

i

T FIELD =

i HEpERE
w 000 3F

--Ei
AR}
1

ELd

-
¥

IRIFLET
ked PSF

FFT-based PSF

=1 =}

£2d

N4 PATCH SHE: L0014 mm OEr4> TRIFLET =)
W11 0,538 T B i W3 0,568 POINT SPREAD FUNCTICHS e

IWE PATH SOE 0.02014mn = 0,060 4m  CENTER (dmm.Shmit

o517

Direct Integration-based PSF

PSF vs. all fields
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Modulation Transfer Function Examples

Through Frequency MTF
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Zoom Lens Analyses
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Other Analyses

I_

MTF & Field Curve vs. Field Line Spread & Knife Edge |-
— i R
s g :
) | Aﬂ_ E N
o | 5
/‘—/‘/‘(\/\’_V : # 0,25
P e I v P R D
Ensq. Energy w/ Diffraction I ]| Polarization State Pupil Map |s
| | ' ' QOO0
o QOO0
2 oel IMCIDENT ﬁ 9 OOQ% %
2 on N EEFEARE
£ 0zl N2 2 R
| Ny
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System Evaluation

e Analysis Method Consistent with
— Design Criteria
— Measurement

e Be Wary of Measurement and Spec “Equivalents”
— Tolerance budget calculated in RMS wavefront
— Final system measured in RMS wavefront

FIELD POINTS FIELD POINTS
— ON-AXIS -
System MTF mees o

1
WAVELENGTHS . WA\/XELENGTHS
m

# A(um) Weight
1 0833 1

eigl
1 0.833 1

PV/RMS Ratio 3.7

PV/RMS Ratio 6.9

640

0 320 480 640
160 320 480
FREQUENCY (CYCLES/RADIAN) FREQUENCY (CYCLES/RADIAN)

7 — o MTF_TYPE PV/RMS Ratio = 3.7
UL CE oD R0 = S NS o2 ko0 DIFFRACTION MODULATION TRANSFER FUNCTIONS
PV/RMS Ratio = 3.7 FBY O FBX O W1 (um) = PV/RMS Ratio = 6.9 FBY O FBX O W1 (um) =
INTERFEROGRAM — W1 FOCUS O 0.6328 INTERFEROGRAM — W1 FOCUS 0O 0.6328

X X
X SHIFT P-V OPD X SHIFT P-V OPD
0 0.4739 0 0.4848
Y SHIFT RMS OPD Y SHIFT RMS OPD
0 0.1269 1.276e-07 0.07035

Similar RMS Wavefronts can have drastically different PV and MTF
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Slider Wheel Interaction with any Analysis

B mow 3

EiEexZa@l e
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Popular Analysis Options

Includes Diffraction?

e \Wavefront diagrams No
e Spot diagrams No
e Ray diagrams No

— Transverse Ray
— Longitudinal ray

e Point Spread Function (PSF) Yes
— Line Spread Function (LSF)

e Modulation Transfer Function (MTF) Yes
— Square wave response

e Encircled Energy Maybe
— Ensquared Energy

For use in UA Opti 517 Class — All rights reserved -Lambda Resea_

OSLO



Optimization Components

Required:
— Error Function (operand set)
« Create OCM operand set (Light and user defined)
« Create “built in” or “direct entry” operand set
— Variables
— Optimize
« OSLO allows you to choose optimization engine: Local or Global
Optional:
— Vignetting Factors
— Data Tables
* Field point set
« Ray table (pupil point set)
« Spot diagram set
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Field Points

e Define Object and Aperture for
Optimization

e Object Points Vary With Zoom
Position

— Cfg 0 means global specification

— Cfg n active in zoom position n
only

e Aperture Varies With Vignetting
— Vignetting varies with apertures
— Use apset and vig cmds

e Drawing Field Points are not
Evaluation Field Points

For use in UA Opti 517 Class — All rights reserved -Lambda Resear_

EE Surface Data E'El— 2
o - =
5 | =
?
[LGen |[ setup |[ wavelength || Field Points |[ variables |[ braw off |[ Group |[ Notes |
Lens: Anamorphic Bravais objective 2x Zoom 1 of 1
Ent beam radius 1.000000 Object height -0.500000 Primary wavin 0.587560
SRF RADIUS THICKNESS APERTURE RADIUS GLASS SPECTAL
0BJ 0.000000 | -10.000000 |  0.500000 arr [ | [
8.46z000 |  o0.150000[__]  1.100000 SK16
[=2] o.ooooo0[ ] 4.200000 ] 1.1o0000 am[__] [
-1.370000 |  o.100000 |  ©0.943398 SK16
o.o00000 |  5.650000 [P |  0.943398 arr [ ] [
o.oo0000 | o.ooo000 | 1.os0000 ]
= Field Points Set Data Editor < Surface Data =@ | &
v "=
% =
?
Spreadsheet style: ® Basic (& Advanced
FFT  CFG FBY FBX

o [IEEEEEEE 1. 000000

0 0. 700000 0. 000000

=] o 1. 000000 0. 000000

OSLO




Ray Set (Pupil Set)

e Specifies Rays Used in Optimization
e Ray Set Can Be Assigned to Any Field Point

e Can Specify Either Ordinary or Reference
Ray

e FY, FX Are Vignetted Fractional Coordinates

e Weight Not Used
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Spot Diagram Set

e Needed for MTF or WVF operands
e Specifies

— Field point

— Aperture divisions

— First wavelength & number of wavelengths
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Variables

e Setup in Lens SS or Variables SS

&
L
i

1 B

=)

_ Lens SS restrlcted to common [Gen |[ Setup |[ wavelength || Field Points || variables || Draw OFf || Group || Notes |

Lens: Anamorphic Bravais objective 2x Zoom 1 of 1
-t Ent beam radius 1.000000 Object height -0.500000 Primary wavin 0.587560
I el I lS SRF RADIUS THICKNESS APERTURE RADIUS GLASS SPECIAL

0B3 0.000000 | -1o.o00000 | 0.500000 atr [ |
8.46zo00 | o.1s0000 [ . 100000 SK16

— V I bI SS I t f =] o.000000[ ] .100000 ] .100000 ] AR ]
ariables pOpS up ISTO [=] -1.370000[ ] 100000 | .943398 SK16

allowed variables Ea Ty Bt Bt

LRI

( TthkneSS defaUItS |n SS £ Variables Data Editor < Surface Data =] = _33

of Select variable lupe: =

|E ;] _:_:1_

) X

e Other defaults in optimization

Defau-]t air-space th'i'ckness bounds: I'-'Ii'n'l'.'nl.m 0. 100000 Maximum 1.0000e+04

nd't' n pefault glass thickness bounds: Minimum 0.500000 Maximum 100.000000
Co I IO S [[vary all curvatures | [ vary all thicknesses | [vary all air spaces |

vV # Surf Cfg Type M i mum Maximum Damping Increment value

1] 1 7 0. 000000 0. 000000 1. 000000

e Don't touch variable damping I —

Curvature pickup multiplier (CVIM)

e Can set values of variables in SS "

Thickness (TH)
Aperture radius (AP)

— Can aISO use Vb Command from Toric curvature (CVX)
the command line
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Operands Spreadsheet

@ Anarnorphic Bravais objective 2x [anamorph.len] - O5LO Premi
PY Enters or EdItS Error FunCtIOn Manua”y File Lens Evaluate Optimize Tolerance Source Tools )

E W = E @E Generate Error Function »
_ . . tﬁdﬁ G rror Function Tables

e Minimize or Constraint Mode L 1-1e E}p Fd L ’
£ Surface Data E ‘

Variables...

. of
o Welght ¥ Slider-Wheel Design...
7

— 0.0 means calculate but don't add to ERF || ecejmemmpn

Lens: Anamorphie Advanced Optimization S
Ent beam radius - ..
o Name Optimization Conditions...
SRF RADTIL :
>
SR EET Support Routines
— Used for Identlflcatlon Only’ Ieadlng %QperandsData Editor < Surface Data EI—E- &2
- o iE
don't displ i .
means dont display ?
0P MODE WGT NAME DEFINITION -
[_a]minl _xavel e
[z minl 0.004167 _X2 X(1,1)
- [ Siminl  o0.003342 _x3 X(1,2)
. Defl n Itlon [_4min] o0.007885 _x4 X(1,3)
[_simin] 0.007885 _xs X(1,4)
[_elmin] o0.003912 _xs X(1,5)
0.005780 _X7 X(1,6)
— 0.011560 _X8 X(1,7)
Component <Op> Component [_siminl 0.011560 _X9 X(1,8)
0.005780 _X10 X(1,9)
[ 1amin] o0.00s780 _x11 X(1,10)
. [ 2gmin] o0.011560 _xa12 x(1,11)
—_— <Op> IS + - * / > < 0.011560 _x13 x(1,12)
b I L L J 0.005780 _X14 X(1,13)
[asimin]  o0.003342 _xas X(1,14)
[_16|min 0.007885 _X16 K(1,15)
[ afmin] o.007285 _xa7 X(1,16)
[ ) Targ et aIWayS O 0 0.003942 _x18 X(1,17)
- 0.000694 _X19 X(1,18)
[zomin] o0.001383 _xz0 x(1,19)
[ =21min] ©0.op1385 _x21 X(1,20)
0.000694 _x22 x(1,21)
23| minl Xrms1 RMS
23] Min] _ravel AVE
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Generate Error Functions
(Item under Optimize menu)
MENU OPTION

e Singlet

e Cemented Doublet

e OSLO (RMS Spot Size/Wavefront)

e GENII (Gray's Method)

e Aberration Operands

e Ray Operands

e Generate Field Points

OPERAND CREATED
OCM+Special Action
OCM+Special Action
Direct Entry Operands
OCM Method/Direct Entry
OCM Method

OCM Method

Does not create operands
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OSLO Error Function

e Evaluates RMS Spot Size or Wavefront
e Based on Forbes' Quadrature Methods
e User chooses number of rings and spokes
e Additional options:
— D minus D chromatic operands
— Square Grid (like Code V)
— Edge Thickness operands
— Distortion operands
— Add to current error function
— Custom weighting for field and wavelength
— Symmetry override

e Available in Standard and Premium Only
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Aberration (OCM) Operands

e Sets up 21 First, Third, Fifth-Order Operands
e Delete Unwanted Operands for final Erf

e Results in OCM's

e Good for simple systems (no tilts, etc)

e Opcb_abs callback (in optim_callbacks.ccl)
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Ray OCM Operands

e Error Function for On-axis and 1 Off-

axis Field

e Oprays_template Generates 21 Ray
Operands

e Arguments Are Off-axis Field Point
and Vignetting

e Delete the Operands You Don't Want

e Opcb rays Callback (in
Optim__callbacks.Ccl)

e Learn more about ray operands by
typing Ray Operands in Help

0SLO Help Overview - Optimization - Generating an Error
Function

Ray Operands

"oprays template” command
Default menu item: Optimize>>Generate Error Function>>Ray Operand
Template

The oprays template CCL command may be used to generate an error
function based on data computed for rays computed from 2 field points.
The way it works is to generate a template error function containing all
the operands that are evaluated by the opcb_rays callbback. You build
your own error function by deleting the operands that you don't want,
either manually using the operands spreadsheet, or programatically such
as is done in the cemdoublet erf error function generator. The available
operands are as follows.

Operand Name OCM#
On-axis fractional beam radius AXIS_FYMAX 0OCM1
Fractional height of off-axis object OFAX_FOB oCcm2
Lower FY for off-axis object point OFAX_FYMIN OCM3
Upper FY for off-axis object point OFAX_FYMAX OCM4

FX for off-axis object point skew ray OFAX_FX OCMS
Paraxial axial ray height PY OCMa
Paraxial axial ray slope PU QCM7
Paraxial chief ray height PYC OCMB
Paraxial chief ray slope PUC OCM9
Effective focal length EFL OCM10
axis focus shift AXIS_FOCUS O0OCM11
axis FY zone dy AXIS_ZDY OCM12
axis FY zone opd XIS_Z0OPD OCM13
axis FY zone dmd AXIS_ZDMD  OCM14
axis FY zone osc AXIS_Z0OS5C OQCMI15
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Operands Spreadsheet

e The operands set is a user-constructed measure of the performance of a lens. The
operands set consists of a number of operand definitions that measure various physical
and optical properties of a lens system; these quantities are combined into a single
figure of merit called the error function (or merit function).

e The Number of the operand is displayed in the first column of the spreadsheet, on a
row button. The operand number is used to refer to this entry in some commands.
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Operands Spreadsheet Continued:

Each operands set entry consists of four fields:

e Definition (see list of available components)
Operand definitions are of the form A, A+B, A-B, A*B, A/B, A**B, A>B, or A<B, where A and B

represent components. The operators "+", "-", "*" "/", and "**" represent addition, subtraction,

multiplication, division, and exponentiation, respectively. The operators "<" and ">" are used to form
"one-sided" operands that have zero value when the expressed relation is true, and have a value
equal to the difference between the components when the relation is false. For example, the
operand with definition "-0.005<SA3" will have zero value if SA3 is greater (algebraically) than -
0.005, but it will be active with a value of -0.005-SA3 if SA3 is less than -0.005. Conversely, the
operand definition "0.005>SA3" will be inactive if SA3 is less than 0.005, but it will be active with a
value of 0.005-SA3 if SA3 is greater than 0.005.

The first component of an operand may be preceded by a minus sign, but the second component
may not be preceded by a minus sign. For example, the operand definition "-0.005<SA3" is legal, but

the (algebraically equivalent) definition "SA3>-0.005" is not legal.
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Operands Spreadsheet Continued:

Mode (OSLO Standard and OSLO Premium only)

The Minimize or Constraint mode is selected by activating the mode cell by clicking on it; this toggles the mode back
and forth between its two possible values. The optimization algorithm attempts to find exact solutions for the constraint
operands, through the technique of Lagrange multipliers. The program attempts to find values of the variables such that
all of the constraint operands have zero value. Note that there must be at least as many variables as constraint
operands for constraint optimization to be possible. Constraint operands are often used to maintain certain conditions of
the lens (e.g., f-number) exactly. The minimize-mode operands are used to form the error function proper. The
optimization algorithm attempts to minimize the weighted root-mean-square value of the minimize-mode operands,

while satisfying any constraint operands.

Weight (Minimize mode only)

Determines the relative importance of an operand in the error function. The default weight is 1.

Name
An operand name, which may be up to ten characters long, is optional. If the name begins with an underscore, " ", the

operand is a "hidden" operand; that is, it is not listed by the operands print command unless the "all" option is specified.

Note that AVE operands and operands between AVE operands and RMS operands are also "hidden."
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Generate Error Function>0OSLO Spot Size/Wavefront

e Ray based error function with direct
editing

e Add to operand set as needed to
control system during optimization.

Generate error function x|

Field zampling method
' Cument ¢ Gaussian © Radau (% Lobatta © Equalareas  Equal heights| Mumber of samplesl 3

 Yes % No

Pupil zampling method
' Gaussian ¢ Radau ' Lobatto ¢ Grid | Fumber of apetue divisions o pupl I £.300000

Trace full pupil for symmetric lens

C Ye: % No —| Murnber of rings [on-axiz field point] I 5

Numberofrings[off-axisfieldpoints]I 3 Numberofspokes[off-axisfieldpoints]I 3

Generate mernidional spokes for off-axis field points?—|

Duplicate field zamples for negative FBY?—|

i Yez  No

Errar function type
% AMS spot size  { AMS wavefront emor

Color comection method

i None © Useall wavelengths © Use CHR/DMD operands | Frelative wemtt of EHEI I aperands I 1.000000
b aximum operand configuration I 1

Comect distartion at full field

i On & 0f —| f aimunn allewed distorbion (pereent] I 1.000000

Generate edge thickness operands

i 0n & 0ff —I Firimum &l awed edoe tHickness I 0.500000

Append to existing error function?
i Yez: % No —|

Cancel | Help |

EE§ Operands Data Editor < Surface Data [ O] x|

?

o “m
BB ==
B3
OF  MODE wWaT NAME DEFINITION =
_ravel JevE_ |
L008333 _v: w(1,13%0. 707107
.0473209 _¥32 ¥(1,2)1%0.707107
LOE2357 4 ¥(1,3]1%0, 707107
LOE9357 | _YE w(1,43%0. 707107
L0473209 _Y& ¥(1,51%0.707107
L008333 Y7 ¥(1,61%0, 707107
Yrms1 RMS
_Havez AVE
L041667 10 #(2,7)
L034722 _x11 #(2,8)
L069444 _x12 (2,9) =
L069444  _x13 ®(2,10)
L034722 _x14 ®(2,11)
.034722 _xiE ®(2,12)
L069444 K16 #(2,13)
L069444 | _x17 #(2,14)
L034722 g (2,15)
L006344  _x13 %(2,16)
.013889 _xz0 ®(2,17)
L013889 X2l ®(2,18)
L006344 _xz22 %(2,19)
Hrms 2 RMS
_raves AVE
L041667 _DY25 Y(2,7)1-024
.034722 _DOvze w(2,8)-024
L069444 _Ovz7 w(z,90-024
.069444 _Ovz8 ¥(2,10)-024
,034722 _DOv22 v(2,117-024 LI
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Generate Field Points

e Sets up Field Point Set Automatically
e Use Quadrature or Grid Methods

e Accommodates Zoom Systems

e Append or Overwrite Current Set

e Menu Option Does Not Create Operand Set

r Append to existing field poirts? —
[ Yes @& No

[ Yes (& No

Generate field points >

Mumber of samples

- Sampling method
" Gaussian " Radau &+ |obatto
(" Egualareas (" Equal heights

Maximum configuration 1

Duplicate field samples for negative FBY? —

Cpen field points spreadshest 7
" Yes @ No

[ ok | t:ancel] Help

% Field Points Set Data Editor = Surface Data

= | e
J e
o [P ]
spreadsheet style: @ Basic (O Advanced
FFT  CFG FEY FEX
=] 0 0. 700000 0. 000000
0 1. 000000 0. 000000

For use in UA Opti 517 Class — All rights reserved -Lambda Resea_ .EI.



Optimization Conditions

e Specify parameters to optimization methods

Optimize  Tolerance  Scurce  Tools  Window Help

Generate Error Function > E D= %S

Error Function Tables ¥

— Specify CCL Routines if Required

Operands... E\

— Damped Least Squares Verables.

Slider-Wheel Design...

lterate..,

« Damping factor, Solution Tolerance, etC. - juunceicptimision B ownit Simplec

s rvative hMatri
Optimization Conditicns... e Brecsbae Mattit

— OSLO Error Function i e 2| iy

Global Explorer...

Background ASA Window

) Weig hti ng terms Run Background ASA...

Stop Background ASA

Foreground ASA..

— ASA parameters Terminate ASA
« Cooling rate, termination condition, etc.
— Miscellaneous

* Infinite reference sphere, ERF printing convention, etc.
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Optimization Methods

e Damped Least Squares

e Downhill Simplex

e Powell's Method

e Adaptive Simulated Annealing (ASA)

e Global Explorer
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Damped Least Squares

e The Gold Standard for Local Optimization

e Minimizes a Function Subject to Constraints
e Uses Derivatives of ERF Wrt Variables

e Optional Lagrange Multipliers for Constraints
e Damping Controls Stability

e Subject to Stagnation

For use in UA Opti 517 Class — All rights reserved -Lambda Resea_

OSLO



Simplex (Nelder-Mead)

e Simple Non-Derivative Method
e Slow, Stable, OK for Simple Problems
e Included mostly for Curiosity

e See Numerical Recipes (Press, et.al.)
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Powell's Method

e Non-derivative Local Method

e Finds Conjugate Directions

e Slow, Stable

e Has Worked (Sometimes) Where DLS Fails

e See Numerical Recipes for Discussion
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Global Explorer

e Multiple Solution Generator

e Damped Least Squares With Escape

Function
e Much Faster Than ASA
e Global Exploration, Not Global Optimization

e Developed by Ishikki, Et.Al.
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Adaptive Simulated Annealing

e True Global Optimization

e \Who Wants It?

e Also Used Multiple Solution Generator (Msg)
— Combined With DLS Local Optimization

e Features Uniform Search

e Most Efficient Global Method Available

e Developed by Forbes and Jones

For use in UA Opti 517 Class — All rights reserved -Lambda Resea_
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Improvements and New Features in OSLO 7

Improvements in OSLO 7
e Improved STEP File Exporter
e Improved Zemax ® /OpticStudio ® importer
e Improved Code V® importer
e Feature Improvements
— Asymmetric Aspheres include base conic (OSLO Premium only)
— Help > Check for Updates
— Help > License
— Updated glass catalogs
New Features in OSLO 7

e New licensing using CodeMeter

New Videos for OSLO 7

New Examples Page on Website and Updated Manuals
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Improved STEP Export

e File>Export Lens to CAD

— Now Exports Conics, Aspheres, and almost all

lens types both for centered and decentered
systems

Export lens drawing to CAD ot

— Lens drawing style [DEF]

€ Meridional section " Sagittal section
€ End-on zection  wire frame
£ Solid model = Solid model [all surfaces)

— Lens drawing stle [[GES]
% perdional section € Sagittal section
€ End-on zection  Wire frame

— Drawing option
& Mome Al surfaces " Cross sections
€ Mo edges drawn " Obscurations drawn

First zurface I 1] Last zurface I 1]
OK | Cancel |  Hel
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STEP Export from the Shafer 5 Mirror system and then
imported into TracePro as a STEP file

@ Shafer Five-Mirror Objective [shafer3mirr.len] - O5LO Premium Early Access Build: 7.0.0.17016

File Lens Evaluate

Optimize Tolerance

BinEERO0@EE S

Source

Tools

Window Help

of Command:

[=]l= ] =

®

2 Coardinates; Tilt and bend

[CGen ][ Setup |[wavelength |[ Field Points |[ variables || Draw off || Group |[ Notes |

Lens: Shafer Five-Mirror Objective Zoom 1 of 1
Ent beam radius 10.000000 Field angle 1.000000 Primary wavin 10. 000000
SRE RADIUS THICKNESS APERTURE RADIUS GLASS SPECTAL
0B1 0.000000 | 1.0000e+20 [ | 1.7455e+18 arr [ | [
-239.500000 ] -160.200000 | 11.000000 [ |ReFL_HaTCH [ |
[ z]-z28.900000 ] 4s.esoc00 |  4.o00000 [ |REFL_HATCH [ ]
=] -7s.s40000 ] -37.240000 [ | do0.o000000 [ |REFL_HATCH [ |
-39.810000 | 39.240000 ]  s5.000000 REFL_HATCH [ ]
-78.720000 | -74.so0000 ]  9.oo0000 [ | REFL_HaTCH [ ]
[ms] o.coooc0 ] o.o0o0000 ]|  1.578320
- Lens Drawing ™ EI £
1+ i

Shafer FiveMirror Objective
OFTICAL SYSTEM LAYOUT

LNITS: M
DES: D. Shafer
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B2 TracePro Brpert

File Edit View Geometry Define Raytrace Optimize Analysis Reports Tools Utilities Macros Window Help
DE | & 4 2| ¢

BEBEQE & &

4

g W EOBBM 5 BB @s s 5K
A

Y RS IETEy B E e el TE W
)l [Tz %z Ix =2 237 & o F 5 % (F 5 6 9 @

= Model:[shaferSmirr.oml]

[

.~ OSL0 Lens 1 REFL_HATCH
~ OSLO Lens 2 REFL_HATCH
~ 0SLO Lens 3 REFL_HATCH
0SLO Lens 4 REFL_HATCH

OSLO Lens 5 REFL_ HATCH]

Model [ Source [Radiance|

OSLO




Improved Zemax/OpticStudio Importer

e File>Import Lens File>Zemax

— Will attempt to import every Zemax commands and will report any problems on
import to the text window. Older importer would stop on the first non-recognized
command.

@ Double Gauss, 30mm /2 20deg [dblgauss.len] - O5L0 Premium Early Ao

File Lens Evaluate Optimize Tolerance Source Tools  Window

Mew Lens... Ctrl+M
Open Lens... Ctrl+0
Save Lens Ctrl+5

Save Lens As...

Load Command File...

Lens Database »
Import Lens File... » GEMII
Export Lens to CAD.. SIGMA

Open Database... \ CODEV
Print Text Window... L
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Steps to use Zemax/OpticStudio Importer

e Step 1 — Close the Surface Data Spreadsheet

e Step 2 — File>Import Lens File>Zemax

e Step 3 —Look in the

Text window for error
Messages

e Step 4 — Check the graphic
windows to make sure that

all rays passed through the
System

e Step 5 — Check that

Apertures are set correctly

@ [Untitled lens] - OSLO Premium Early Access Build: 7.0.0.17016

File Lens Evaluate Optimize Tolerance Source Tools Window Help

= e TPy ]

D

(SRR
_I

@ Setup |[ Wavelength |[ Field Points |[ variables |[ oraw on ][ Group |[ Notes

Iﬂlliﬂ
> |REN

Lens: DEMO SHOWS APLANATIC SOLVE Zot 1 of 1 Ef1 o0.819570
Ent beam radius  0.750000 Field ang]e 5.7296e-05 Primary wavin  0.550000
SRE RADTUS THICKNESS APERTURE RADTUS GLASS SPECTAL
FEE] 0.000000 [ ]| 2.000000[ ] 2.0000e-08 ar[ ] []
-z.000000 | o.so0000[ | z.coo000[ A BKL —1
[z] -o.3003s0[s5] o.osoc00[ | 1.000000[ | awm[] [
[ 31 -3.szssza[ | o.sooo00[ | 1.400000[ | eaa[c] []
[ 4] -o.962952[5] o.oso000[F] 1.400000[ | ar[] [
[ 5] -6.5os413[ | o.soooco[ ] 1.700000 ] exa[c] [
[ 6] -2.ase163[s5] o.oso000[F] 1.700000 [ ] ar[ ] []
[ 7] -10.776910 ] o.soooco[ ] 1.s00000 [ ] EKL —1
[ 8] -4.292611[5] o.oso000[F] 1.s00000[ ] ar[ ] []
[ 2] -27.098s27[ | c.soocco[ | 2.000000 [ | BKL —1
[(10] -7.7#s113[s5]| o.os0000[F] z.ooo000[ | ar[_] [
-26.655631[ | o.soocc0[ |  z.oooooo[ | sal[c] [ ]
-13.212707[5] o0.034490[S] z.o00000[ | ar[ ] [
[13] 1s0.930138[ | o.sooooo[ |  z.oooo00 [ | BKL 1
[12] -24.602718[ | 1.o00000[ ]  2.000000 [ ] am[ ] []
[35] o.oo0000[ ] zo.o00000[ ] z2.eesssz[ s | ar[]

™S o.000000 ] o.oo0000 [ ] 21.210135 [ S| — v

DEMD SHOWS APLANATIC SOLVE
FOCAL LENGTH = O.8198 NA = 0.868

UNITS: M
DES: OSLe
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S [=r= s
B8 Len Spe Rin Ape Wav Pxc Abr Mg Ci Tra Sop Ref Fan Spd Auf e O e
~

ZLENS INPUT
SRE 0t
LID: DEMO smws APLANATIC SOLVE ?_—__—_—
UNT
UNT
E£8R 0.750000
WVF_REF_SPH_POS  Exit pupil
WAVLNS 0.550000
Wl 1.000000
SRE 01
v --
TH 2.000000
SRE 1:
AST 1
SRF 1:
v -0.500000
TH 0.500000
GLA BK1
MNOR command (marginal ray normal solve) not supported by OSLO
AP 1.000000
SRE 2:
v -0.663584
TH 0.050000
SRE 2:
ALC
aF 1.000000
SRE 3:
v -0.261129
TH 0.500000
GLA  BKL
MNOR command (marginal ray normal solve) not supported by OSLG
AP 1.400000
SRE 41
v -0.383751

0.050000
ALC

z
AP 1.400000
SRE 5:
v -0.151621 o




Second Example using Zemax/OpticStudio Importer

e Step 1 — Close the Surface Data Spreadsheet

e Step 2 — File>Import Lens File>Zemax

@ [Untitled lens] - O5LO Premium Early Access Build: 7.0.0.17016

File Lens Evaluate Optimize Tolerance Source Tools Window Help

CEFREFI T T

(=@ ==
v o
x I =l
[Gen | Setup ][ Wavelength |[ Field Points ][ variables || Draw On_|[_Group | Notes |
Lens: THREE GLASS APOCHROMAT Zoom 1 of 1 EF1 100.000000
Ent beam radius 5.000000 Field angle 5.72962-05 Primary wavln 0.546000
RE RADIUS THICKNESS APERTURE RADIUS GLASS SPECTAL
OB] 0.000000 | 1.0000e+20[ | 1.0000e+14 am[_ ] [_]
90.488914 | 1.o00000 ] s 1
[ 2] 1.4934e+03[_] t.ooocoo0 | 4. 1
23.440925 | z.oooo00[ ] 4. 1
[ a] -63.o7z432 ] s9s.sz7edz[ | 4. 1
™S o.o00000 | o.oo0o00 ] o 1
oy |E\| = | =
THREE GLASS APOCHROMAT UNITS: WM
FOCAL LENGTH = 100 NA = .05 DES: OSLO
2.02
"

Ewie

EA Len Spe Rin Ape Wav Pxc Abr Mrg Chf Tra Sop Ref Fan Spd Af Vi Oue Be
*LENS INPUT

SRF Ot

LID: THREE GLASS APOCHROMAT
UNL m
UNT mm
EBR 5.000000
WVF_REF_SPH_FOS Exit pupil
WAVLNS 0. 404000
W2 0. 480000
W3 0.548000
wWua 0. 600000
WS 0. 656000
Wwl 1.000000
Ww2 1.000000
W3 1.000000
ww4 1.000000
WWS 1.000000
WAVLNS 0.546000
WWl 1.000000
W2 0. 404000
W2 1.000000
Wv3 0. 480000
W3 1.000000
wWva 0. 600000
w4 1.000000
WvE 0. 656000
WWS 1.000000
SRF 0O:

v e

TH 1.0000e+20
SRF 1:

AST 1
SRF 1:

v 0.011051
TH 1.000000
GLA F2

SRF 2:

v 0.000670
TH 1.000000
GLA KZF56

SRF 3:

v 0.042660
TH 2.000000
GLA FK51

SRF  4:

v -0.015855
TH 98.827642
SRF &:

v =

TH -

END =
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Improved CodeV Importer

e File=>Import Lens File->CodeV

— Will attempt to import every CodeV command
and will report any problems on import to the
text

@ Double Gauss, 30mm /2 20deg [dblgauss.len] - OSLO Premium Early Ace

File Lens Evaluate Optimize Tolerance Source Tools Window

Mew Lens... Ctrl+M
Open Lens... Ctrl+0
Save Lens Ctrl+5

Save Lens As..,

Load Cammand File...

Lens Database *

Import Lens File... » GEMII
Export Lens to CAD... \ SIGMA
Open Database... CODEV

Print Text Window... _—
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Steps to use CodeV Importer

e Step 1 — Close the Surface Data Spreadsheet

e Step 2 — File>Import Lens File>CodeV

@ [Untitled lens] - OSLO Premium Early Access Build: 7.0.0.17016

File Lens Evaluate Optimize Tolerance Source Tools Window

& HEEO %NS

Help

e Step 3 - Look in the

= |

Text window for error

[_setup |[ wavelength |[ Field Points |[ variables |[ braw off |[ Group |[ Notes
:Double Gauss - U.5. Patent 2,532 Zoom 1 of 1 EFl 104.128543
[ Field angle 14.000000 Primary wavin 0.656300

RADIUS THICKNESS APERTURE RADIUS GLASS

.000000 [ | 9.9z9seriz[ | 2.4782e+11

aw[_]
<]
Messages

e Step 4 — Check the graphi

Windows to make sure that

Bl

| OOOOO0O00000C

Double Gauss - U.S. Patent 2,532
FOCAL LENGTH = 104.1 KA = O.2401

UNITS: Mt
DES: ' !

all rays passed through the

(%)
S

System Eau—

e Step 5 — Check that

Apertures are set correctly p
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HH Len Spe Rin Ape Wav Pxc Abr Mig Chf Tra Sop Ref Fan Spd Auf Var

SLENS INPUT
SRE 0

Double Gauss - U.S. Patent 2,532,751
LID: Double Gauss - U.S5. Patent 2,532

EER 25.000000

UNT mm
NI mm

WAVLNS 0.656300

w2 0.587600

w3 0. 486100

W1 1.000000

ww2 1.000000

W3 1.000000

bEs %

ANG 14. 000000

SRF 0:

RD e

TH 9.9394e+11

GLA AIR

SRF  1:

RD 57.445765

TH 8.746658

IN GLA()

GLA  BK7

#UPDATE VARTABLES

VE SN CF TYP MIN MAX DAMPING
v 1 1= e - = 1.000000
END

SRF 23

RD 188. 460067

H 0.298182

IN GLAQ)

GLA AIR

ZUPDATE VARIABLES

VE 5N CF TYP MIN MAX DAMPING
vz 2 - av - - 1.000000
END

FUPDATE VARIABLES

VE SN CF TYP WIN MAX DAMPING
vz 2 - TH - -- 1.000000
END

SRF 3:

RD 34.887272

T 12.4242320

IN GLAQ)

GLA SK1

FUPDATE VARIABLES

VE SN CF TYP MIN Max DAMPING
v o4 3 - o = = 1.000000
END

SRF 4

RD

TH E

IN GLAQ)

GLA FiS

SRF 5:

RD 21.469207

TH 15.107864

IN GLAQ)

GLA AIR

FUPDATE VARTABLES

VE SN CF TYP MIN MAX DAMPING
V5 5 - oo - -- 1.000000

END

INCR
4.0000e-06

INCR
4.0000e-06

INCR
0.002500

INCR
4.0000e-06

INCR
4.00008-06

VALUE
0.017407

VALUE
0.005306

VALUE
0.298182

VALUE
0.028664

VALUE
0.048578

LO




Second Example using CodeV Importer

e Step 1 — Close the Surface Data Spreadsheet

e Step 2 — File>Import Lens File>CodeV

@ [Untitled lens] - OSLO Premium Early Access Build: 7.0.0.17016

File Lens Evaluate Optimize Tolerance Source Tools Window Help

BB NEEG®

i 8

8

=

[=lE]=
B8 Len Spe Rin Ape Wav Pxc Abr Mrg Chf Tra Sop Ref Fan Spd Ad *

STORED GLASS UNKNOWN

STORED GLASS UNKNOWN
Reading C:\Users\Public\Documents\0sLO7 Premium Early Access\private/bins/glc/private.glc

[cen |[setup ][ wavelength || Field Points || variables || Draw Off || Group || hotes |

Lens: Cassegrain Ritchey-Chretien Zoom 1 of 1 EF1 1.7521e+03 writing C:\Users\Public\Documents\OSLO7 Premium Early Access\private/cdb/glass_private.cdb
0.600000 Primary wavin 0.632800
SRF RADIUS THICKNESS APERTURE RADIUS GLASS SPECIAL ZLENS INPUT

SRF 0O:
sNoz2

.000000 | 1.0000e+10 | 1.0472e+08 arm[ ] [
.gs7z00 | -z60.000000 | 75.000000 REFLECT |
.232796 ] 471.717084[] 2z.500000 ] RmeFLecT[] LID: Cassegrain Ritchey-Chretien
.zzee70 ]|  7.sooooo [ ] 1e.s01850 [ s | sF11 1 EBR  75.000000
498104 [ | .ooooo0 [ | 17.832237 awm [ ] [ gﬁ -

(-

Cassegrain Ritchey-Chretien

n

.o00000 | -o0.01e7as[ ]| 18.347856 [ 5 | WAVLNS 0.632800
Wwl 1.000000
ANG 0.600000

:UW'I-LensDraw?ng" E’ 2 '?SF o: .

1:] : TH 1.0000e+10
X - GLA AIR
Cassegrain Ritchey-Chretien LNITS: b B e
FOCAL LENGTH = 1752 NA = 0.04281 DES: G8LO e
GLA REFLECT
AST

1
##* Command CON not recognized #=#*
cC -1.046192
2:

33.9 piE 2
AP 75. 000000
SRF 2:
RD  -290,232796
TH 471.717084
IN GLA()

GLA REFLECT
#+* Command CON not recognized ##%

cC -2.915001
AP 22.500000
SRF 3:
RD -55.229670
TH 7.500000
1] IN GLAQ)
U GLA 5SF11
SRF 4:
RD -118.498104
TH 5.000000
IN GLA()
GLA AIR
SRF &
RD o,
TH -0.016718
GLA AIR
END 5
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OSLO 7.1 Global Explorer 2 Demonstration
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Global Explorer Two Operands setup by Angle CCL

e You can use the Angle CCL i fode] =

EA Len Spe Rin Ape Wav Pxc Sbr Mrg Chf Tra Sop Ref Fan Spd Auf Var Ope lte

that comes with Ge2 to 2
=== selected On-Axis Fprt ===

automatically setup the chief . 5 000 0.00 -1.00000 1.00000 -1.00000  1.00000
=== selected On-Axis Ray ***

and marginal rays to setup R“’;S G‘Jt”'j Al E‘.SF;:.; 0. 00000

the Global Explorer L i e LN s e e
***3 0 1.DD_ D:DD —D;EEDDD 0. 80000 -0. 80000 0. 80000

optimization parameters. o e g ey

R 5 oOrdinary 1.00000 0. 00000
R 11 oOrdinary 0. 00000 1. 00000

After inVOking the Angle CCL R 12 Ordinary -1.00000 0.00000

the operands are changed >> ope
. *OPERANDS
and reported N the text OF MODE WGT NAME VALUE %CNTRE DEFINITION
O 50 M 4.8000e-11 ANG_Rms_1 25.499454  0.00 RMS
. . OEL M e EOT_Limit = -- 050=0.0
WlndOW as ShOWﬂ at rlght 0 52 M 1.0000e+03 Top_Limit s -—  ©O50«<90.0
059 M 0.250000 Yrmsi 0.028588 0.21 RMS
. 0O GE M 0.500000 XrmsZz 0.201845 20.47 RMS
and the Mlnlmum RMS ErrOr 077 M 0.500000 Yrms2 0.287626 41.57 RMS
OB M 0.125000 Xrms3 0.277410 9.67 RMS
. . D a5 M 0.125000 Yrms3 0.454192 25,92 RMS
IS ShOWﬂ at the bOttom glVIng o102 M 0.125000 CHRrms1 0.041813  0.22 RMS
o111 M 0.500000 CHRrms2 0.038057 0.73 RMS
. 0O 120 M 0.125000 CHRIMS3 0.028267  0.10 RMS
us a startlng error for the 0124 M = 7.070081  -- PL(4,20,1,5)+PL(4,20,1,6)
0131 M -- 6.322051 -- PL(4,21,1,5)+PL(4,21,1,6)
0 135 M  10.000000 -0.010533  1.12 PU+D.142875
defaUIt SyStem_ MIM RMS ERROR: D.009374
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GE2 Results using Angle than Ge2 commands

e You can use Global = ==l
EEG<z=a @il
Explorer and the new 20, M e, 2| 5 5

Global Explorer 2 %@

optimization routine ﬁ

coming in OSLO 7.1 to do

gIObal Optimization These FREQ 425 Ang 74.73 M 0.0002868 | FREQ 247 Ang 22.84  MF 0.0004723) FREQ 298 Ang 24.53 MF 0.00102
4.07 4 ss 3 & 6

optimization routines
search global solution m

space for multiple

solutions based on user

FREQ 5 M 0.001085 | FREQ B4 Ang 24.47 ME Q.0017| FEEQ 117 Ang 32.56 ME 0.01175
criteria. For a triplet o, 7|2, 8| s, 9
design, we asked GE2 to %
search solution space to j ) \
minimize an angular merit %

function The 9 Solutions FREQ 5 Ang 29.86 M 0.7349 | FREQ 1 Ang 31.65 M- 8,764 | FREQ 1 Ang 52,73 M7 Bet1Y

are shown at left.
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